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PBCS Allocate Application - Basics

PBCS (Planning & Budgeting Cloud) is a web-based planning solution that drives collaborative, event-based
planning and forecasting models. Planning is an all-in-one tool for the end-to-end and closed-loop planning
process that drives continuous business improvement. Planning provides the ability for all users to communicate
the appropriate course of action to take and allows the budget holders to collaborate so that the planning
process is streamlined and efficient.

Components of PBCS

The following Oracle Cloud products are included in the UND PBCS Environment:

®  Planning & Budgeting Cloud Workspace

® Smart View for Office

Planning & Budgeting Cloud Workspace
Workspace provides a single business performance management interface that enables you to access PBCS and
Financial reports.

Smart View for Office

With SmartView, you can enter data in Microsoft Excel spreadsheets using the same data forms available in the
PBCS Web Client. You can take the data forms offline for the added flexibility of working with them while
disconnected from the data source. Smart View also allows you to perform Ad-hoc queries when necessary.
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Dimensionality

PBCS is a multidimensional database server optimized for planning, analysis and management reporting
applications. PBCS utilizes dimensional hierarchies and consolidates data. Plan data entered into the Planning
application is then stored in a multidimensional database.

Overview
Dimensions are the actual descriptors of the base elements that describe and hold data. Years, Scenario, Version
and Accounts are all examples of dimensions.

Within each dimension, the individual elements are called members. UG Tuition is a member of the Account
dimension and Define is a member of the Version dimension.

Dimension Hierarchies
Members of dimensions are arranged in hierarchies. These hierarchies create relationships between the
members that reside on the various levels of the hierarchy.

Upper-level members are called parent members and the members immediately below them are called their
children. All members below a parent are called descendants and the bottom-level members are called base
members (or Level 0 members).

Metadata
Metadata describes the data values in a database. Metadata includes dimension names, member names,
properties and security.

For example, the member name College of Arts & Sciences, describes the data related to the College of Arts &
Sciences expenses and the member name March describes the data related to March. Therefore, March College
of Arts & Sciences identifies the Metadata for the College of Arts & Sciences expenses for the month of March.

Multidimensional View
PBCS data is stored in a cube where the faces of the cube represent dimensions. With a multidimensional cube,
each face represents a dimension. For instance, a dimension might be Years, Scenario or Account.

Dimensions are the highest level and within each you may have hierarchies. For example, within the Period
dimension, there are quarters and months as a hierarchy.
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Drilling down is the process of retrieving progressively detailed data from a dimension by expanding a parent
member to reveal its children. The expansion can reveal hierarchical relationships, such as those between a parent
entity and its child entity, a parent account and a child account or a summary time period and a base time period.
For example, drilling down can reveal the hierarchical relationships between a year and quarters or between a

quarter and months.

Identifying Member Branches - Families
The following terms describes the common family relationship terms used in PBCS:

Dimension The top most member of a dimension

Parent A member that has at least one child below it

Child A member that has a parent immediately above it

Sibling A child member at the same branch level as another child member with the same
parent

Ancestor Any member in a branch above a member

Descendant Any member below a parent
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Dimension Ye a r
Qt r1 Ancestors of April
Descendants of Year Qt r2

Year April
Qtr1

Siblings Qt r2 Parent of April
Ap ril Child of Qtr2

As the above depicts, Year is the dimension. Qtrl and Qtr2 are siblings and they are also children of Year. Qtr2 is the
parent of April. Qtrl, Qtr2 and April are all descendants of Year. Qtr2 and Year are ancestors of April. However, note
that Qtrl is not an ancestor of April since April and Qtr1 are on different branches of the Year hierarchy.

Identifying Member Branches - Levels
A member’s location within the outline can also be referred to by levels. This is a reference to the member’s

location within an outline from a bottom-up perspective. The lowest level members are designated Level 0. The
levels increase as you move up to the dimension name.
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Understanding the PBCS Allocate Applications Dimensions

PBCS Allocate Dimensions

PBCS allows you to set up to two standard plan types in your application. For each plan type created, PBCS
creates an associated database. When you create the account, entity and other dimensions of the application,
you associate them with a plan type. This allows you to create databases that contain dimensions and data that
are relevant to each plan type and allows for optimal application design, size and performance. Data can be
shared between plan types as needed.

Within the PBCS Allocate Application, only one Plan Type is currently being utilized.

Account

The Account hierarchy is the created based on a consolidated level of GL revenue and expense accounts.
Additional accounts have been added for drivers (such as Credit Hours Consumed/Instructed, Square Footage,
FTEs and Headcount). There are also other accounts created for the purpose of calculations and to input
percentages.

The Account dimension has added functionality such as time balancing. Time balancing relates to how a given
account should aggregate its value across specified periods of time. For example, a user may take the weighted
average value of an inventory account in a given period, or use the first or last month of data. The user may also
tag accounts as “Revenue” or “Expense” to aid in identifying the data polarity (signage) in variance reporting.

Period
The Period dimension relates to the Months that comprise UNDs fiscal year (July - June). This dimension consists
of Months, Quarters, BegBalance and YearTotal.
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Fiscal Years start in 2012 and continue through to 2018. More years will be added as time moves forward.

Year Alias (Default)
FY12 FY 2012
FY13 FY 2013
FY14 FY 2014
FY15 FY 2015
FY16 FY 2016
FY17 FY 2017
FY18 FY 2018
FY19 FY 2019
Scenario

The Scenario dimension is used to describe the type of data being used. Scenarios include:

e Actual —Unallocated
e Actual —Allocated

e Manage Plan

e Plan

° Forecast

e Projected

Actual data is always loaded into Actual — Allocated Scenario, where revenue allocations will be run. From there,

these post-allocated Actuals will be used to seed the Plan and Forecast for out years.

Actual-Unallocated
ActPlanVar
TotalScenarios
Actual-Allocated
Plan
Forecast

Actual to Plan Variance
Total Scenarios
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Version
The Version dimension is used to separate different data sets for the annual Plan and all Forecasts. There are

four Versions that will be utilized, based on the fiscal calendar and updated driver sets. These include:

Define (July — December)
Refine (January — May)
Complete (End of June)
What - If

- Version

Dataload
Totalversions Total Versions
Define
Refine

Complete
Whatlfs

Data Load

What If Versions

Fund

The Fund dimension is used to incorporate Actuals and Plan at a consolidated Fund level. All funds are mapped

into the following Fund categories, via the Data Management tool and predetermined mappings that can be
referenced in the UND PBCS Data Load Process guide:

Restricted

Grants & Contracts

Appropiated

Local

Unrestricted

Other_Plant

Strategic

SUA Fund (this is solely used for the Service Unit Allocations)

Fund
AllFund All Fund
TotalFund Total Fund
Restricted
Unrestricted
Other_Plant
Strategic
SUAFund SUA Fund
NoFund No Fund
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Using PBCS - UND Primary Units

LogIn

Navigate to the PBCS website.
Enter your identity domain: unorthdakota

File] £ View] Hiztery ] Boekmarks | Toelz] Help

- -] x
[ UND: University of Morth . X Sign In Ta ORACLE CLOUD B
€ © @ hitps:/ioginus2.oracedoud.com/oam/server/obrareq.cgitencqueny33DOSBLIFS DMVWC2FNwaTYZjs 14 TmrhpUMsqRECNsd2sgfCQTt98%2B1 HCUMSSRTHENS oS tp2HFWBESFF | @ Q Search w0 © & B- & & =

B Mot Visied @ Getting Strted [ Log on o PecpleSt| [ Prod-PBCS [ Test-PBCS @ SpacePolicyChartpef | WD Sanford Members | @ Oraci | PeapleSaft En. ol for Incentive-B.. 8 THI Connect  Signin. (] Doshbosrds [ Sites | & Oracle| PeopleSos Ent.. (] Buid iDeshboards

SIGN IN TO

Enter your Identity Domain
unorthdakota

[ Ramamber my chice @

Go

ORACLE’
Capynight ® 2013, 2015, Oracle andior its afflistes. All rights reserved
Enter username and password:
Sign In To ORACLE CLOUD x T
©) © & | hitpx/oginus.oraddoudcomioam/server/auth cred submit e | Qserch %09+ H &S =

[B Most Visited @ Getting Started B Log on to PeapleSoft| (8] Prod-Pacs (&) Test-PBCS @ SpacePolicyChartpdf | W8 Sanford Members | 4. Oracle | PeapleSaft Ent... 1] iDeshbosrds:. - Admin [l Model for Incentive-8.. ™ Tl Connect: Signin 1] iDsshbosrds 35 Sites | £ Oracle | PeopleSoft Ent... 1) Build iDashbosrds

SIGN INTO

Welcome unorthdakota sange somsin @

odela fuquagund.edu

Can'access your account?

ORACLE"

Copynight © 2013, 2015, Oracle andior its affliates. All ights resenved
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Click the Oracle Enterprise Performance Management — undpb environment.

S50 Enabled | F v sarah edu v
ORACLE' CLOUD My Home 4 My Profile
My Oracle Services | pomain: uorthdakota ~ Data Center US Commercial 2 s

Oracle Enterprise Oracle Enterprise My Services
Performange Mana... Performance Mana...
undpb-test
Double Click Launch Application
) =TET=]

e £ oradedoud.com/workspace a-

geting Cloud Service Workspace:

%
V)

Launch Appication Watch Demo

Documentation

Smpified Interface

You should be at the My Task List section on the left hand navigation.
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Task 1.00 - Review Drivers: Credit Hours, Headcount, FTEs, and Square
Feet

1. Inthe center panel, click the green arrow icon under the column Action for the line labeled 1.00 Review

Drivers.
@ Planning and Budgeting Cloud Service Workspace - Mozilla Firefox E D @
il ) @ nhttpsy//undpb-unorthdakota.pbcs.us2.oraclecloud.com/workspace/indexjsp a-

Planning and Budgeting Cloud Service Workspace Logged in as odela.fuqua@emai.und.edu |undpb Help Logoff O

Navigate Fie Edit Vew Favortes Tooks Administration —Help

A B n  Expoe|

-_—
Planning and Budgeting Service search: | R © -o:nce

~
~ Forms Task List Status
oM Task Lists
anage faskld Task List Status - All View >
My Task List

> B Academic units Task List
 nconplete
W Complete
Overdue

Incomplate, 1000%
Task List Status - All

Task List Tasks - All

§ Tk Type Status Start Date End date Aert Completed Date  Instruct Action
9 Academic Units Task List =] ] B
2 UND Plan Process Overview =) [r] [} B
{7 1.00 Review Drivers 2 7] &3 B
9110 Review Credit Hours [} 7] &3 B
f491.20 Review Headcount, FTES and Square Footage [} 7] & B
##2.00 Input Direct Revenue and Expenses [} 7] & B
#9300 Review Model Income Statement =] B B

> Preferences

> Diagnostics

2. At the bottom of the screen, click Next to advance to the next step in the task list.

3 e
.
R Goerd & & -[JF 7 @
. . .
Forms Task List Status
Manage Task Lists

Task - 10D Review Drivers. Tack nciructins
My Task List

S 5 Inconplete
B academc Units Task Ust

B 0 Pran Process Overvien
o Rereworer]

& 2.00 bnput Drect Revenue and Expenses

9 3.00 Review Model Tneome Statement

Preferences .

Diagnastics Completz | Previous Incomplete || frevus | Mgxtneompletz || Hext
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a. Task 1.10 Review Credit Hours: this task will allow you to view the drivers used for the Student Credit
Hour calculations. CRC stands for College of Record, and CRI stands for College of Instruction. See
Appendix A for the graphic look at UND’s Scenarios and Versions Process.

i.  Update your point of view using the drop downs at the top of the sheet and click the arrow at
the end of the line to refresh the page.

Versions:

Actual-Allocated = Actuals and is only located in Complete

ManagePlan = Current fiscal year and is only located in Refine or Complete
Plan = Next fiscal year and can be Define, Refine, or Complete

Forecast = Future fiscal years and can be Define, Refine or Complete

Task - 1.10 Review Credit Hours | Task Instructions Refreshes your selection. }—\

FY 2016 ¥ | Complete il

> Year Total

Planning and Budgeting Cloud Service Workspace

Navigat= Flle Edit Mew Favorites Tools Administration Help

A B voselB @ & g

Planning and Budgsting Service | Allocate - Task List Status

> Forms Task List Status
> Manage Task Lists Task - 1.10 Review Credit Hours | Task Insiructions
My Task List
] 015 ~| actual-aloca ~c ~| Total Aca Jrits ~
B Academic Units Task List FY 2016 actual-llocated Complete Total Academic Unit (]
¥ UND Plan Process Overvien ey
B | 00 Review Drivers CRC - Traditional Undergraduate Alumni Dependent (ALDEP) 23
i CRC - Traditional Undergraduate Contiguous States (CONTT) 479
& 1 20 Review Headcount, FTEs and Squ CRC - Traditional Undergraduate Midwest Student Exchange Program (MHEC) 15,700
& 2,00 Input Direct Revenue and Expenses CRC - Traditional Undergraduate Minnesota Freciprocity (MINNR) 106,223
& 3,00 Review Mode! Income Statement €RC - Traditional Undergraduate Western Exchange Program (WUE) 11,362
CRC - Traditional Undergraduate North Dakota Resident (NDRES) 104,189
€RC - Traditional Undergraduate North Dakota Miitary (NDMIL) 13,582
CRC - Traditional Undergraduate Non-Resident (N_RES) 15,396
Total Traditional Undergraduate - CRC 272,044
CRC - Online Undergraduate Alumni Dependent (ALDEP) 13
CRC - Online Undergraduate Contiguous States (CONT) 677
€RC - Orline Undergraduate Midwest Student Exchange Program (MHEC) 2,597
CRC - Online Undergraduate Minnesota Recprodity (MINNR) 7,209
4 €RC - Orline Undergraduate Minnesota Professional (MNPRO) 7
CRC - Online Undergraduate Westem Exchange Program (WUE) 1,640
CRC - Online Undergraduate North Dakota Resident (NDRES) 9,514
CRC - Online Undergraduate North Dakota Miltary (NDMIL) 1,926
CAC - Online Undergraduate Non-Resident (N_RES) 2,130
Total Online Undergraduate - CRE 25,713
CRC - Graduate Alumni Dependent (ALDEP)
€RC - Graduate Contiguous States (CONTI) 2,945
CRC - Graduate Midwest Student Exchange Program {MHEC) 6
CRE - Graduate Minnesota Recprogty (MINNR) 8,369
CRC - Graduate Minnesota Professional (MNPRO) 813
CRC - Graduate Westen Exchange Pragram (WUE) 237
CRC - Graduate North Dakota Residznt (NDRES) 39,09

ii.  Your screen will refresh with the point of view selected, as shown above.
‘ Note: If numbers do not match what you expected, check your point of view selections.

iii. Click Next on the bottom toolbar to review the drivers for Headcount, FTE, and square footagel

Complete [ | |Previous Incomplete| | Previous | | Mext Incomplete| | Next | | Task List Home
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b. Task 1.20 Review Headcount, FTEs, and Square Footage: this task will allow you to view the drivers
used for the staff, faculty, and student headcount and FTE for each as well as square footage.

> Forms Task List Status
> Manage Task Lists Task - 1.20 Review Headcount, FTEs and Square Footage | T=ck Instructions
My Task List
F] Fr 2016 ] Actus-alocated ~] Complet ] Total Academic Units -
B pcademic Units Task List ! i omeet ° s =
B D Plen Process Overview Acar]
B 100 Review Drivers Total Staff Headeount 72
9 1,10 Review Credit Hours Total Facuity Headcount 8%
i OReveuhedomEReaa 1 Erolovee Headeount 1,55
2,00 Input Direct Reverue and Expenses IS 2
93,00 Review Model Income Statement oalbaciviE B
Total Employes FTE 1,515
Total Square Footage 1,244,826
Total Square Footage based on exd for Faciities Mgt - Utities 1,080,521
Total Square Fostage based on excl for Faclities Mot - Custodil Services 1,089,603
Total Square Footage based on exd for Fadlites Mgmt -Maintenance 1,089,693
‘
< >
> Preferences
> Diagnostics Complete [] | Previous Incomplete || Previous

i. Click Next at the bottom of the screen.
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This input form is used to capture your unit’s direct revenue and direct expense budgets. You will be given an
Excel spreadsheet to enter the details with PeopleSoft fund, department number, and account budgets to assist
in calculating figures for entry into the PBCS form.

‘ Remember to verify your point of view to make sure you are entering into the correct year, scenario and version.

a.

Enter figures in appropriate category. To see updated total, click the save icon in the toolbar.

a.

Navigate File

h B o

Flanning and Budgeting Service

» Forms

Please note that transfers to cash balance should be entered a negative amount, and transfers
from cash balances should be entered as a positive amount.

Edit View Favorites Tools

- Explore | B @ = | &

> Manage Task Lists
My Task List

P Academic Units Task List

i UMD Plan Process Overview

P 1.00 Review Drivers

Ei|zm Input Direct

&9 1,10 Review Credit Hours
&9 ) 20 Review Headcount, FTEs and Squi

and Expel

£ 3,00 Review Madel Income Statement

Administration  Help

R

m R 8

Allocate - Task List Status *

Task List Status

FY 2016

Direct Tuition - Graduate
Graduate Waivers
Met Grad Tuition
Federal Grants and Contracts
State/Local Grants and Contracts
Private Grants and Contracts
Total Grants and Contracts
Gifts
Investment Income
Endowment Earned Income Distribution
IT Services
Leases, Rents, Royalties
Medical Charges
Registration Fees
Other Sales and Services
Interdepartmental Revenue
Total Sales and Services
Apartment and Residence Hall Revenue
Parking Permits
Season Tickets
Other Auxiiary Revenue
Total Auxiliary Enterprises
Faculty
Staff
GA
Other - Salaries
Total Salaries and Wages
Employee Benefits

Building, Grounds, and Vehide Maintenar

e = PEolore | B )

¥ | Actual-Allocated

Restricted

-5,311
-5,311
37,376,033
6,371,409
6,016,734
49,753,554
2,385,001
435

66,182

o4

38,405
8,345
46,804

6,500,773
8,678,104
2,854,474
2,438,717

20,472,069
5,899,896

160,176

Task - 2.00 Input Direct Revenue and Expenses = Task Instructions

| Complete

> Year Total

Unrestricted
29,090,383
-6,051,080
23,039,808
1]
-4,528,215
16,752
41,568,153
2,496,510
186

113
502,791
11,538,699
221,447
20,430,242
8,766,937
41,460,229
7,372

1,650

42,240
51,262
91,434,106
27,785,655
5,037,543
5,679,245
129,936,550
38,500,912
3,394,218

Other_Plant

¥ | Total Acac

Total Fund
29,090,833
6,056,391

23,034,497
37,376,033

1,843,194
6,033,486
91,321,706
5,331,511
621

66,182

113
502,845
11,538,699
221,547
20,468,646
8,775,282
41,507,033
7,372

1,650

42,240
51,262
97,334,880
36,463,760
7,892,017
8,117,962
150,408,619
44,400,808
3,504,394
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Prior to running the task 3.00, you need to complete the initial report set up outlined in Appendix B. You only
need to complete the report set up once; your preferences will be saved for future sessions.

Task 3.00 - Review Model Statement

This task will create the Model Income Statement with any changes inputted in tasks 1 and 2.

a. Select the appropriate point of view fields:
For example:
a. Years: FY16

b. Scenario: Actual-Allocated
c. Version: Complete
d. Unit: [Your Unit]
e. Fund: TotalFund (Always select)
f.  Source: UserView (Always select)
g. Click OK
b. PBCS will generate a model statement for the unit.

a. If your changes don’t appear in your model statement, check that you entered them in the same

POV as the model statement parameters.

Preview User Point of View =

This report/book runs for the members on the user Point of View listed ~
below.

Years

FY 16 Select...
Scenario

Actual-Unallocated Select...
Version

Complete Select...
Linit

EERC Select...
Fund

TotalFund Select...
Source b

Help oK Cancel

15|Page
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@ Planning and Budgeting Cloud Service Workspace - Mozilla Firefox

i) @ | hitps:/fundpb-unorthdakota.pbcs.us2.oracledoud.com/workspace/indexjsp

Planning and Budgeting Cloud Service Workspace

Explore: Primary Unit Reports | IncomeStatement - One Year and Year Total *

JPrimary Unit Reports/IncomeStatement - One Year and Year Total
| Years: FY17 | | Scenario: Plan ‘ | Version: Complete | | Unit: BPA | | Fund: TotalFund | | Source; UserView |
Model Income Statement lN') UNITVERSITY OF
For FY 2017 P N RT KO A
Plan
Complete
Revenues
Tustion
General Tuition - Tradtional Undergraduate (Instruction) 6,748,385
General Tuition - Tradtional Undergraduate {Record) 5424032
General Tuition - Online Undergraduate (Instruction) 685,970
General Tuition - Online Undergraduate (Record) 485,654
Undergraduate Waivers {690.300)
Net UG Tuttion 12,653,242
Direct Tuttion - Graduate 1.016.870
Graduate Waivers {271.115)
Net Grad Tuition 745,755
MN Reciprocity Deposits 459,937
Total Net Tuition 13.858.934
Student Fees
Course and Program Related B831.769
Total Student Fees 831,769
Approprztions
Alloc of Gen State Approp to Research 347915
Aloc: of Gen State Approp to Instruction 8,324,955
Total Appropriations 8,672,869
Grants and Confracts
Met Federal Grants and Contracts {117.309)
Net State/Local Grants and Contracts (221)
Total Grants and Cortracts {117.530)
Indirect Cost Recovery 117,530
Gifts 1.480.628
Investment Income 7.042
Sales and Services
Other Sales and Services 912,549
Total Sales and Services 912,543
Audliary Erterprises
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Reports

There are several standard reports in PBCS.

e  Driver Comparison Report — This report compares the data drivers of a unit with the choosen POV and also
gives a comparison of the university drivers with the same POV.

e  Driver Comparison Report condensed version - This report compares the data drivers of a unit with the
choosen POV and also gives a comparison of the university drivers with the same POV. Expand the
headings to see the breakdown in each category.

e IncomeStatement — One Year and Year Total — This report displays one year model statement for a unit

e IncStmt — One Year and Year Total with Fund breakdown — This report will show the totals broken down
by fund type: appropriated, local, grants and contracts, restricted. There are two other funds on the report,
strategic and SUA fund; however, they can be ignored. They are used for the allocation of service unit
expenses. Those expenses are then manually copied to the local or appropriated column depending on
the unit. The Strategic and SUA columns net each other to zero.

e IncStmt — One Year and Year Total with Fund, Account breakdown- This report displays one year model
statement of a unit with the breakdown of funds and accounts.

e IncStmt - Three Year Variance Report by Unit — This report compares the model statement for a unit for
three years for the choosen point of view.

e IncStmt - Three Year Variance Report by Unit and Fund - This report compares the model statement for a
unit for three years for the choosen point of view and fund.

e IncStmt - Two Year Variance Report by Unit - This report compares the model statement for a unit for two
years for the choosen point of view.

e IncStmt - Two Year Variance Report by Unit and Fund - This report allows you to run a variance between
two points of view for a specific fund type.

Any report can be exported to Excel by clicking on the File menu on the toolbar, Export and Excel

Running Reports

1. Select Explore on the tool bar at the top of the screen.
@ Planning and Budgeting Cloud Service Workspace - Mozilla Firefox

il ' ) & | https)//undpb-unorthdakota.pbcs.us2.oracledoud.com/workspace/index.jsp

Planning and Budgeting Cloud Service Workspace

Navigate File Edit View Favorites Tools Administration Help

A B s (% Explore)

Flanning and Budgeting Service

» Forms Task List Status
» Manage Task Lists
My Task List

Task List Status - All

» I Academic Units Task List
> B Other Units Task List

B Incomplete
W Complete
Overdus

Incomplete, 100.0%
Task List Status - All

Task List Tasks - All

17|Page
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Double click the Primary Units Reports folder.

@ Planning and Budgeting Cloud Service Workspace - Mozilla Firefox

i ' © @ | https://undpb-unorthdakota.pbes.us2.oradecloud.com/workspace/indexjsp

Planning and Budgeting Cloud Service Workspace

View Favorites Tools Help

A= Explore I =5

Planning and Budgeting Service

Folders /
[[J Root I # Name - Type Modified Description
[ Budget Office Reports [ Budget Office Reports Folder 9f1/16 3:19PM
[E7 Primary Unit Reports [E7 Primary Unit Reports Folder 9/9/16 7:45 AM
[£7 Sample Content [£7 Sample Content Folder 8/30/16 1:18 PM Contains sample data loaded up atinstall time.
[£7 shared Workspace Pages [£7 shared Workspace Pages Folder 8/30/16 1:13 PM
» [ Users [£7 Users Folder 8/30/16 1:18 PM

3. Double click the desired report.

[Primary Unit Reports

I % Name - Type Modified Description

Driver Comparison Report Finandal Reporting  6/28/18 10:48 AM
IncomeStatement - One Year and Year Total Finandial Reporting  6/28/18 10:50 AM Total Univ Model Stmt collasped cost pools
IncStmt - One Year and Year Total with Fund breakdown Financial Reporting  6/28/18 10:51 AM Total Univ Model Stmt collasped cost pools
IncStmt - Three Year Variance Report by Unit Financial Reporting  6/28/18 10:53 AM Total Univ Model Stmt collasped cost poals
IncStmt - Three Year Variance Report by Unit and Fund Financial Reporting  6/28/18 10:54 AM Total Univ Model Stmt collasped cost pools
IncStmt - Two Year Variance Report by Unit Financial Reporting 6/28/18 10:55 AM Total Univ Model Stmt collasped cost pools

| IncStmt - Two Year Variance Report by Unit and Fund Financial Reporting 6/28/18 10:55 AM Total Univ Model Stmt collasped cost pools

4. Choose the ‘User Point of View’ for all the Dimensions (Years, Scenario, Version, Unit, Fund, Source) that you
want displayed by clicking on ‘Select’ button for each.

For Source choose ‘TotalUserView’

Preview User Point of View =

This report/book runs for the members on the user Point of Yiew listed below.

Years

e @
Scenario

Flan Select...
Versian

Complete Select...
Unit

BPA Select...
Source

TotalUserview Select...

Help oK Cancel
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Use the l‘ﬂsign or click on to expand on the members.

Preview User Point of View =

Members
Available: Years (1-11of 11)
Find: Mame | é Use Wildcards [ ] Case-Sensitive

E=n @ﬂRows Per Page: 5op | v

Name Default
O:l (D) Years
A1 (yFYi2 FY 2012
A yFr13 FY 2013
1 yFria FY 2014
K (FYis FY 2015
%1 (yFYis FY 2016
# yFY17 FY 2017
# yFyis FY 2018
#1 ) FY20 FY 2020

* 3 substitution Variables

Help Cancel

5. For Variance Reports first choose the ‘User Point of View’.
Next choose ‘Respond to Prompts at Grid Level’. There will be two/three sets of parameters to choose the

POVs to compare. Click the ﬂ magnifying glass to choose your point of view. Use tab key to scroll down.
Click OK.
Preview User Point of View =

This repart/book runs for the members on the user Point of View listed below,

Period

h’earT-:utaI Select...
Unit

BPA Select...
Source

TotalUserview Select...

Help Cancel
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Respond to Prompts b

~

The following prompts have been defined in the repart. You may use the default values shown, or select other members,

‘ Respond to Prompts at Grid Level V’

Prompt Selection Type Source
Choose Report Report: IncStmt - Two Year
Comparison Year: Variance Report by Unit

Grid: Grid1

O Edit Member Names

Choose “ Repart Report: IncStmt - Two Year
Comparison Year: Variance Report by Unit
Grid: Grid1

O Edit Member Names

Choose Version; “ Report Report: IncStmt - Two Year
Variance Report by Unit
Grid: Grid1
W

Help Cancel Reset
6. A new tab will open for the report.

Planning and Budgeting Cloud Service Workspace

View Favorites Tools Help

E r " Exlore I Lo I R ]

Planning and Budgeting Service Explore: /Primary Unit Reports Incomestatement - One Year and Year Total =

Years: FY19 Scenario: Plan Version: Complete Unit: BPA Fund: TotalFund Source: TotalUserView

You can also change your POVs from this screen by clcking on the blue boxes.
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To export a report to excel, click File>Export>Excel.

@

|f-:—;' https://undpb-unorthdakota.pbes.us2.oraclecloud.ce

Planning and Budgeting Cloud

Navigate | File| View Favorites Tools Help
Mew

Open 4
Open In 4
JPrimai Close * Annual with Fund Expan
Years: Export r Excel [
Preferences... Word
PowerPoint
Log Off —
Exit ne Statement
I'UI_I'I FAVN K]
Plan

8. To navigate to the report listing, click the Explore:/Primary Unit reports tab.

Planning and Budgeting Clo

Navigate Fle View Favorites Tools Help

A B m Booe| R Ty

Planning and Budgeting Service Explore: /Primary Unit Reports IncStmt - Annual with Fund Expansion Available *

{Primary Unit Reports/IncStmt - Annual with Fund Expansion Available
Years: FY18 Scenario: Plan Version: Refine Unit: TotalUniversity Fund: TotalFund Source: Useryiew
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Changing You Password in PBCS

LogIn

CONSULTING GROUP

1. Navigate to the PBCS website.
2. Enter your identity domain: unorthdakota

File] £ View] Hiztery ] Boekmarks | Toelz] Help

B UND: UnivestyofNoth X SgninTo ORACLECLOUD X | .
€

B Mot visicd @

- 8 x
@ | hitpss/s

0,5 2. oraddecioud.com/a

¢ Q search

0 9 & G- W O

for Incentive-B.. ™ THI Connect: Signin (1] iDashbosrds ) Sites |  Oracle | PeopleSoft Ent.. (1] Buikd iDashbosres

SIGN IN TO

Enter your identity Domain

unorthdakota

[ Remember my chaice @

ORACLE"

Copynight © 2013, 2015, Oracle andior its aliates. All ights reserved

3. Enter username and password:

File] £ View] Hiztery ] Boekmarks | Toelz] Help

o -] x
Sign In To ORACLE CLOUD x =
€ © @ | hitpsyfiogin.us2.oradecoud.comyoarm /server/auth_cred_subrmit

. @ | Q Search
B Mt Visied @ Getting Started [ Log on to PecpleSoft| . [E] Pros

0 9 & G- W O

[ Test-PECS @ SpacePolicyChartpcf | W Sanford Members | & Oracle | Peapleoft nt.. 11 iDashboards. - Admin (B} Modelfor ncentive-8.. % THi Connect: Signn (1 iDsshioards [ Sites | & Oracle| PeopleSoft Ent.. 1 Buil Doshboards

SIGN IN TO

&

Welcome Unorndakota sange semain €
odela fuquagund.edu

Can'taccess your acoount?

ORACLE"

Copynight © 2013, 2015, Oracle andior its affliates. All ights resenved
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Click the down arrow next to your user id in the top right corner. Select “My Profile” from the drop down list.

ti - 8

unorthdakota | ® Preferences v sarah.abentroth@und.edu v
ORACLE’ cLOUD My Home My Account
My Services
Help »
My Profile
My Oracle Services  oomain: unorthoakota ¥ & DataCenter US Commercial 2 About
Diagnostics
Sign Out
Oracle Enterprise Performance Management
undpb

Oracle Enterprise Performance Management
undpb-test

My Services

4. Enter your current password and your new password in the change password fields. Click “Submit.”

| % P v sarah indedu v
ORACLE’ CLOUD My Home My Oracle Services

My PrOﬂ |e Data Center. US Commercial 2 (Time zone: US/Ceniral)

User Information
Note: Identity domain administrators can update First Name, Last Name and Email from the Users lab in My Senvices; these cannot be updated via My Profile

First Name  Sarah
Last Name Abeniroth

Email sarah abentroth@und edu

Change Password
Current password will expire on 29-Nov-2017 6:49 AM CST.

*0ld Password ) Password Policy
*New Password
* Confirm New Password

Submit Reset
9 Change Challenge Questions

* Cumrent Password

* Question 1

5. You have sucééééf‘ully changed your password!
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Adding a Comment in PBCS

You can add comments to each cell in the “Input Direct Revenue and Expenses” task table as outlined below.
1. Select the input task in the Allocate Task List.

Forms
Manage Task Lists
My Task List
I Budget Office Task Lists
¥ Other Units Task List
_ UMD Plan Process Overview

¥ 1.00 Review Headcount, FTES and Square
%¥'2.00 Input Direct Revenue and Exper

5" 3,00 Review Income Statement

2. Select the point of view you wish to review.

FY 2018 *|  Plan A Refine A Housing & Dining Services hd ﬂ

3. Right click on the cell to which you want to add a comment, and select Comments from the menu
option.
Restricted Unrestricted Other_Plant Total Fund

1 [ Copy to What-If Version

325,000 Edit , 325,0

Adjust 2
@ Comments
= Supporting Detail
@ Change History
& Attachments
@ Lock/Unlock Cells
;g Analyze
<) New Ad Hoc Grid
4,600 Select All 4,6

325,000 325,0

Data Validation Messages
Apply 3
30,000 30,0

4. Select the green plus sign to open the comment dialogue box.
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2 Source: User View

Huron

CONSULTING GROUP
B vears: FY 2018

Account: 472000, Period: YearTotal, Fund: Unrestricted
Actions » View ~ 4 3¢ [

x
[, Scenario: Plan [ version: Refine

.1‘1-'"Unit: Housing & Dining Services

Comment
No data to display

User Date

Help

5.

Type comments as desired and click “Add.”
Comments

Close

' Source: User View ﬁ\’ears: FY 2018
Account: 472000, Period: YearTotal, Fund:
Tahoma 12 B & [g|@ 7% .V ah -
BIVY s, 8§ ==

= EE &% &2

x
[ scenario: Plan [ version: Refine i, Unit: Housing & Dir Insert
Unrestricted

Comments

Type comments as desired.. |

Apply to all selected cells []
Help

Cancel

Close
6. The added comment will display as a listing.
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Comments X
'/, Source: User View ﬁ\’ears: FY 2018 Z_f""Scenario: Plan Zj""‘u"ersion: Refine "’."'Unit: Housing & Dining Services

Account: 472000, Period: YearTotal, Fund: Unrestricted ﬂ

Actions v View « 4* |§|

Comment User Date
Type comments as desired... sarah.abentroth@u._. 4/18/17

-
Help Close

7. Additional comments can be added with the green plus sign or comments can be deleted with the red X.
8. Close the comments box when finished.
9. The input form will have a blue mark on the cells for which comments were entered.

FY 2018 v Plan - Refine A H
Year Total
Restricted Unrestricted Other_Plant Total Fund

Direct Tuition - Graduate

Graduate Waivers

Net Grad Tuition
Federal Grants and Contracts 325 325,000

StatefLocal Grants and Contracts

Private Grants and Contracts

Total Grants and Contracts 325,000 325,000
Federal ICR Amount

StatefLocal ICR Amount

Private ICR Amount

Indirect Cost Recovery

Gifts
Investment Income 4,600 4,600
Endowment Earned Income Distribution

IT Services

Leases, Rents, Royalties 3{),000‘ 30,000

Medical Charges

Registration Fees

10. To review the comments, right click on the cell and select comments to display the comments log.
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Comments
'/, Source: User View ﬁ\’ears: FY 2018 .E'-ELScenario: Plan .E'-.:-"'Version: Refine :"T'Unit: Housing & Dining Services
Account: 472000, Period: YearTotal, Fund: Unrestricted | v |
Actions v View « # b |§|
Comment User Date
Type comments as desired... sarah.abentroth@u._. 4/18/17

Help
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Appendix A: UND Scenario/Version
Process

UND SCENARIO/VERSION PROCESS

Forecast (All Other Model Out Years)

Actual-Unallocated {Current Fiscal Year) Actual-Allocated (Current Fiscal Year) ManagePlan {Current Fiscal Year) Plan (Current Fiscal Year + 1) SEMI-ANNUALLY (JAN/IUN CURRENT

MONTHLY MONTHLY ANNUALLY - JUNE (END OF CURRENY FY) SEMI-ANNUALLY (JAN/JUN CURRENT FY)

Load Actuals ONLY Bun Actual Allocations/Seed Future Plans EINALIZED Current Year Plan Lnzolne MextFiscal Year Plan (Uodate
Twice a Year w/ Updated Drivers) {Updated Twice a Year)

Load Direct R
Data by Unit

Define
{Jun Prior Fiscal Year)

Update Direct Update Direct Rev/

by Unit

Update Drivers {Jan-lun 2

Prior F¥/Jul-Dec Prior FY)

Refine
(Jan Current Fiscal Year)

Load Direct (| Load Direct Re
Complete Plan (next Fiscal Data by Unit Data by Unit
Year) baecomes Current

Fiscal Year Complete

[MONTHLY) Manage Plan Load Drivers [Prior FY) Load Drivers (Prior FY)

Complete
(Jun Current Fiscal Year)
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Appendix B: Initial Reports Setup

The first time you use PBCS, you will need to set up your report preferences as outlined.

1. Click Explore.

Planning and Budgeting Cloud Service Workspace

Navigate File Edit Mew Favorites Tools Help

# B = (% BExplre) @ & &
Planning and Budgeting Service Explore: | %
Folders /
[] Root Name o Type Modified Description
Budget Office Reports Budget Office Reports Folder 9/12/18 1:46 FPM
&[] Miscellaneous Reports [ Miscellaneous Reports Folder 8/12/18 1:57PM
[ Primary Unit Reports [ Primary Unit Reports Folder 9/27/18 4:15PM
> [[J Sample Cantent [[) 5ample Content Folder 5/27/17 9:33 PM Contsins sample data loaded up at install time,
[ Shared Workspace Pages [ shared Workspace Pages Folder 1/25/18 4:39 PM
b Users Users Folder 1/25/18 4:33 FM

2. Select File>Preferences.

e

| @ https://undpb-unorthdakota,pbcs.us2.oraclecloud.com/waorkspace/index,jsp

Planning and Budgeting Cloud Service Warkspace - Interne

Planning and Budgeting Cloud Service Workspace

Navigate | File| Edit Miew Favorites Tools Help

A B New
QOpen
Planni Close
Folders Export... !
I y ! # 4 Name a Type Modified
Import
[ Properties... Alt+Enter [ Blfdﬂe’f Ofﬁ_te Reports Folder 9/1/16 2:19 PM
[ Subscribe. . [E7 Primary Unit Reports Folder 11/23/16 10:40 AM
[ - [£7 Sample Content Folder 8/30/16 12:18 PM
[ Preferences... [£7 Shared Workspace Pages Folder 8/30/16 12:18 PM
1 Users Folder 8/30/16 12:18 PM
[ Log Off L 30/
Exit

3. Select Financial Reporting. Under the User Point of View, click Preview “On.” Then click “Setup

Members”.
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Preferences
= Financial Reporting
‘l‘—
General General Reporting Studio

Default Preview Mode
(@) HTML Preview
(") POF Preview

User Point of View

Finandal Reporting Preview

Flanning

Setup Members...

Query-Ready Export

Mode Export To

(®) Smart View (@) Mew Worksheet
() Excel Grid {7y New Workbook
(") Disabled

Word Export

Export As

() Image

(@ Document(.docx)

Help

Huron

CONSULTING GROUP
X

Merge Eguivalent Prompts

Annotation Print Details. ..

Thousands Separator
(@) Comma

(") Period

(") Underscore

() Space

Decimal Separator
(") Comma

(@) Period
() Underscare

() Space

Date Value Format

MMM d, yyyy (=

oK Cancel

4. Make sure the Database Connection is showing Allocate in the drop down box. Click on the Refresh button

to setup the User POV.

Setup User POV

Select a database connection and then select the members you want to be available to you when using the User Paint of View,

Database Connection: I Allocate

=)
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5.

Setup User POV

O F

RTH DAKOTA

ron

CONSULTING GROUP
After clicking “Refresh”, you will see the following form with all available dimensions. Selections will need to
be changed for the Account, Unit, and Version dimensions only. You will click on the button circled in

screenshot below for the dimension that you want to select the POV value.

Select a database connection and then select the members you want to be available to you when using the User Point of View,

Databasze Connection: Allocate ~ | Refresh
Dimension Choices List
Account All Members Al
Period All Members E] All
Years All Members &1 Al
Scenario All Members &1 Al
Version All Members All
Unit All Members All
Fund All Members &1 Al
Source All Members E} All
Display Member Label as: Member Name ~
Dimension Labels are: Induded ~
Member Selection Displays All Members Regardless of £
* This setting applies to all Flanning datasources.

oK Cancel Apply (M)

Help
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CONSULTING GROUP

Account Dimension: Click the magnifying glass on the Account line. Click the blue tab next to the account
folder to open its contents. Then put a check mark in the dimension members IncStmt, UnitMargAccts,
and Drivers. Next Click on the right arrow circled in the screenshot below on the right side of the screen.
This action will place those fields under the name column. Once they are in that column, click on the OK

at the bottom of the form.
Preview User Point of View

Members
Available: Account (1-5 of 5, 451 Total)

Find: Mame | |F

&' &l ZjRowsPerPage: 2p |

MName
D:I [ Account
* EdfAncstmt
> D@Jnih‘ﬂargnccts

> D@)rivers

» 3| | substitution Variables

Preview User Point of View

Members
Available: Account {1-5 of 5, 451 Total)

Find: Mame e |~
@“ &l gl rows Per Page: 2p | v
MName
3 [JAccount
> B3 []incstmt

> CO [JUnitMargAccts
* B3 [Jorivers

> B3| | substitution Variables

Help

@ [/]Use Wildcards [ ] Case-Sensitive

Default

Income Statement

Unit Margin Accounts

L] Use Wildcards [ ] Case-Sensitive

Default

Income Statement

Unit Margin Accounts

Selected:
~ ~ RowsPerPage: 20 |+

Mame

Selected: 1-30f 3
A w Rows Per Page: 20 |«

MName

O #3) Incstmt

D # UnitMargAccts

O #: Drivers

concel
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Version Dimension: Click the magnifying glass on the Version line. Click the blue tab next to the version
folder to open its contents and again on the TotalVersions folder. Then put a check mark in the
dimension members listed: Define, Refine, and Complete. Click the blue tab next to the Whatlfs folder,
and check the box for any Whatlfs versions associated with your unit. Next Click on the right arrow circled
in the screenshot below on the right side of the screen. This action will place that field under the name
column. Once it is in that column, click on the OK at the bottom of the form.

Preview User Point of View
Members
Available: Version (1-20 of 21) # Selected:
Find: Mame ﬂ * L] [+] Use Wildcards || Case-Sensitive v Rows Per Page: 20 ﬂ
o @.—J Rows Per Page: 20 [v/]
Name Default Name
A
D] [[]version
#3 ] Dataload Data Load
4 [ ] TotalVersions Total Versions
# [/ Define
4 [ A Refine
1 [ F Complete
B3 [ whattfs What If Versions

#. ] what-If-Budget Office

# [ What-If
v
A2 ] WhatTf_AS \What T - ARS
Preview User Point of View x
Members
Available: Version (1-20 of 21) * Selected: 1-4 of 4
Find: Name [v] = (] [/] Use Wildcards [ ] Case-Sensitive ~ v Rows Per Page: 20 [v|
@' gl gl Rows Per Page: 20 v
N;
B whatfs What If Versions a CLE
O . Define
# 7] What-If-Budget Office
O #4 Refine
#4 [] what-If
| i Complete
# ] WhatIf_as What If - ABS
® O #2] What-If
#3 [] Whattf_wc What If - WC ]
#3 [] WhatIf_AS.2 What If - ARS Version 2
4 ] whatif_AS.3 What If - A&S Version 3
#4 [7] WhatlIf_BPA What If - BPA
#4 [T] WhatIf_EHD What If - EMD
A ] WhatIf_Law What If - LAW v
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Unit Dimension: Click the magnifying glass on the Unit line. Click the blue tab next to the unit folder to
open its contents and continue to drill into the
folder>TotalUnits>TotalUniversity>PrimaryUnits>AcademicUnits. Under AcademicUnits choose your unit
(as an example BPA has been selected in the screen shot below) and click on it. Next Click on the blue
right arrow circled in the screenshot below on the right side of the screen. This action will place that field
under the name column. Once it is in that column, click on the OK at the bottom of the form.

Preview User Point of View

Members
Available: Unit (1-20 of 60) #

I Find: Mame ~*
I ﬁ“ lﬂ Rows Per Page: 2p9 |«
[Junit

I Dtl [ Totalnits
D:I [ Totaluniversity
D:I [ PrimaryUnits
D-:l [ AcademicUnits

1 [ ass

#1 [ eHD

Preview User Point of View

Members
Available: Unit (1-20 of 60) *

Find: Mame ||
£ & &y rRows Per Page: 20 |w
53 Junit

3 [rotaiunits
&= [JTotaluniversity
| [ PrimaryUnits
& ] AcademicUnits

# [Jaas

# era

% [JeHD

# cem

1 Jnur

% o

# Craw

A [ sMHs

Help

&t Use Wildcards [] Case-Sensitive

Total Units

Total University

Primary Units

Total Academic Units

College of Arts & Sciences

College of Business & Public Admin

College of Education & Human Dev

& []Use Wildcards [ ] Case-Sensitive

Total Units

Total University

Primary Units

Total Academic Units

Caollege of Arts & Sciences

College of Business & Public Admin
Caollege of Education & Human Dewv
College of Engineering & Mines
College of Nursing

School of Aerospace Scences
School of Law

School of Medidne & Health Sdences

Selected:

b3

~ ~RowsPerPage: 20 |v

Mame
*
A
Selected: 10f1
~ ~ HowsPer Page: 20 |w
Mame
O 1 gpa,

W

Cancel
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6. After all preferences have been set, click on the Apply button at the bottom right corner of the form. Click

OK.

Setup User POV #

Select a database connection and then select the members you want to be available to you when using the User Point of View.

Database Connection: Allocate *~|| Refresh

Dimension Choices List

Account IncStmt, UnitMargAccts, Drivers “ All
Period All Members “ Al
Years All Members “ Al
Scenario All Members “ Al
Version Define, Refine, Complete, What-If “ All
Unit BPA Bl a
Fund All Members “ All
Source All Members “ all
Display Member Label as: Member Mame e

Dimension Labels are: Induded b

7. This will take you back to the preferences form. Click okay and you will be ready to run reports.
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Appendix C: Technical Issues

1. Issues viewing reports or Model Statement in PBCS

Clear the cache and cookies of the internet browser you are using. The University Information Technology
website provides instruction on how to clear your browser cache.

2. Supported Browsers (Source: Oracle.com)

Lists the supported and recommended browsers for Oracle Enterprise Performance Management Cloud.
Table 1-1 Supported Browsers for Each Client Platform

Recommended
Client Platforms Browser Other Supported Browsers

Windows 7, 8, 8.1, and 10 | Firefox ESR 45+
Internet Explorer 11

Google Chrome 45+
Apple Mac with OS X Firefox ESR 45+ Safari Version 6 through 10. At this time, EPM Cloud is not
10.9.5 or higher supported on Safari Version 11.
Linux (all versions) Firefox ESR 45+ Google Chrome 45+
iOS (7.x and 8.x) devices Safari version 9 None
Android (4.x and 5.x) Google Chrome 45+ | None

devices

Note:

Oracle Account Reconciliation Cloud and Oracle Enterprise Performance Reporting Cloud can be accessed from
Apple computers running Mac OS X. Use Safari version 10 or lower if you are using Mac OS X.

e Internet Explorer should be used in standard mode. Do not enable Compatibility View and

Enterprise Mode.

e See Oracle Mobile Application Framework 2.1.0 Certification Matrix for a list of supported mobile
devices.

3. To ensure access to the service, you must configure your browser to (Source: Oracle.com):

e Accept cookies from oraclecloud.com and cloud.oracle.com

By default, the browsers are set up to accept cookies from websites. If your browser is configured to
not accept cookies from sites, you must allow a per session or permanent exception for these sites

e Allow pop-up windows from oraclecloud.com and cloud.oracle.com
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